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June 11, 2008 

• For two decades, ECLIPSE has created seamless integration with other software using 
DDE. This Microsoft technology now causes ECLIPSE (and many other programs that 
use DDE) to appear to “freeze” during data export. A new configuration option allows a 
specific DDE message to be suppressed. Select System or Workstation from the File | 
Utilities | Configuration menu. On the Import/Export/Email tab, check the DDE: 
Suppress DDE broadcast messages during export option. 

 
June 10, 2008 

• The Inventory tab for each CPT code now stores a “reorder” amount. 
• A new inventory report on the Reports menu appears under the new Inventory heading. 

It coalesces inventory items where the Ordered from fields match into individual order 
forms. These can optionally be checked & printed. 

• NPI related changes for ANSI Institutional electronic billing. 
 
June 6, 2008 

• Changes made 6/4/2008 could affect CMS 1500 forms by duplicating information from 
box 33a in box 33b.  

 
June 4, 2008 

• User defined index: sort key overrides are no longer attached to bills to ensure that 
remittance information can be imported back into ECLIPSE. 

• Template based forms printed from the ledger’s Print dialog EHR tab didn’t retrieve form 
fields prior to printing. 

• When creating a patient’s SOAP note, the Review the last SOAP option from the I want 
to… button menu allows you to review your last SOAP entries w/o retrieving them 
individually. A Copy button has been added to allow you to copy selected/highlighted 
text & paste it into your current note. Don’t forget that you can easily duplicate the 
current note directly from the EHR tab with randomization. 

• After changes made 5/18/2008, the assigned facility wasn’t appearing on electronic “print 
capture” billing which used the 08/05 CMS form. 

• CMS 08/05 1500 form (printed & electronic print capture): Various changes to boxes 
17a, 24j, and 33b to handle payers with requirements outside CMS guidelines for 
5/23/2008 mandate. 

• The Payer Electronic Claims tab has a new checkbox to allow inclusion of employer 
ID’s or social security #’s in ANSI claim file past the CMS 5/23/2008 deadline: Add EIN 
and/or SS# as secondary ID’s. 



 
May 29, 2008 

• Updated various reports which display phone #’s to automatically locate valid phone #’s. 
Thus, if the home & work fields are empty, but a cell # has been entered, a report such as 
Trace Patient Visits will now display the cell phone # rather than leaving this area blank. 

• Added data filter to locate Group ID#. 
 
May 28, 2008 

• In 2007, CMS mandated that legacy ID#’s be eliminated entirely by 5/23/2008. In order 
to ensure a seamless transition, this date was built into ECLIPSE. Unfortunately, it 
appears some carriers have ignored the mandate and still want legacy ID#’s to appear 
along with the NPI. This update contains a configuration override to allow that. If you 
need to generate legacy ID#’s: 

o Select System from the File | Utilities | Configuration menu. 
o Under Basic options, scroll to the last checkbox labeled Restore legacy ID#’s to 

pre 5/23/2008 CMS NPI mandate (override at payer level). 
o Check the box. Your bills will now be generated in the same manner as they had 

been prior to 5/23/2008. 
o If/As necessary, you can then turn this behavior off for individual payers. Payers 

can be accessed by selecting Database Tables from the File menu and then 
selecting Payers from the list. On the Printed Claim Options tab for the payer, 
mark the checkbox labeled Print NPI only. Override CMS deadline. 

• Updated ASCII data export options to include balances over 120 days. 
 
May 18, 2008 

• Case based facility assignments could be lost by following a specific & fixed set of steps. 
This has been corrected. 

 
May 15 2008 

• Fixed Last Visit Date filter added 5/8/2008. 
• While investigating a separate issue, we’ve managed to add an enhancement that can 

significantly improve performance. In order to maximize the improvement, reindex your 
files at some point (it is not necessary to do it immediately) after loading this update: 
Select Rebuild selected file / indexes from the File | Utilities | Repair menu. Press the 
Mark All button. Then press Rebuild Indexes. This operation is best performed on the 
same computer your data resides when you are the only user. 

 
May 8, 2008 

• Added new CurrentUser variable to allow form letters & templates to be “signed” by the 
currently logged-in user. 

• Added functionality to the Last Visit Date filter. The Detail2 column now allows you to 
optionally exclude patients with future appointments. 

• When a patient’s current condition is displayed & you press the Next Condition button 
on her Condition tab, you are prompted to create a new condition & potentially copy 
information from the current condition. You will now be separately prompted to copy 
authorizations too. Though this feature has been requested by multiple clients, 
authorizations are tied to a specific diagnosis and are generally not meant to carry 
forward to a new condition. 

 
May 3, 2008 



• Added functionality to Appointment filters. This filter now defaults to active 
appointments only. A new checkbox allows you to optionally include cancelled and/or 
rescheduled appointments as well. 

• Updated ANSI 837 electronic billing to use payer overrides that favor using SS# before 
the provider’s EIN. 

• Updated ANSI 837 electronic billing for PR. 
 
April 25, 2008 

• Fixed a problem with text messaging that resulted in a “message too short” error. 
• Enforced checking for Medicaid ID#’s during ANSI 837 billing. 
• On the patient’s Ledger tab, the Patient Paid & Payer Paid columns are calculated “on 

the fly.” For performance reasons, assumptions were made that line-item payments would 
never be credited to future services. This has been updated. 

 
April 23, 2008 

• Fixed scheduler issue with displayed hints on the By Provider grid. 
 
April 17, 2008 

• UB04 changes for IA Medicaid. 
• IL Medicaid HFS 1443 form changes to field 12. 

 
April 16, 2008 

• IL Medicaid HFS 1443 form: fixed printing problem. 
• Added icons to views introduced 4/14/2008. 

 
April 14, 2008 

• A new view has been added to the Bills grid on the patient’s Ledger tab. Right click your 
mouse on a specific bill & select View services & attached line items for selected bill to 
view a popup dialog.  

o This view displays a tree with the services & payments attached to the bill. The 
display is in chronological order. 

o Line item credits applied to each service appear in sub-trees under the assigned 
service. If these credits are associated with a payer, the payer appears as yet 
another sub-tree under the credit. 

o Line item credits are separately totaled as either payments or adjustments. If you 
use the Expected reimbursement field for the associated office code, the expected 
amount is displayed as well. 

o Buttons to expand or collapse all the nodes simultaneously are also provided. 
 
April 10, 2008 

• Added IL Medicaid form HFS 1443. TPL related fields are not printed. Required fields 
have been filled out as per the HFS handbook. 

 
April 7, 2008 

• Send TXT messages to patients. Right click any patient appointment in the scheduler to 
send a text message... 

o You must have internet access and your configuration must be setup as it would 
be to send bulk email. See the 7/5/2007 README entry for additional 
information. 

o For best (and usually immediate) performance, you should select the patient’s 
carrier & assign it (e.g. Cingular, Verizon, T-Mobile, etc) on the patient’s 
Personal tab under Contact Info. Each carrier uses a specific email domain for 



text messages. If the carrier field is left as Unknown, ECLIPSE will default to 
teleflip.com (a free service). However, Teleflip is often overwhelmed during the 
day and the intended recipient may not get the message. 

o This feature will not be added as a “bulk” feature at this time. Please keep in 
mind that many of your patients may not have unlimited text messaging and will 
incur a charge each time you send a text message to their cell phone. 

• If you’re adding a document within the EHR, the assigned provider defaults to the office 
(0-0). This has now been updated to default to the patient’s assigned provider. 

• CMS 1500 changes for IN Medicaid. 
 
March 28, 2008 

• Bulk duplex scanning issue fixed. 
 
March 26, 2008 

• Added a new button to the text editor to allow new paragraphs to be quickly started 
with a pointing device (e.g. mouse). 

• OCR (Optical Character Recognition) is employed by Medicare to machine-read your 
CMS 1500 forms. That’s the reason those forms use special red ink. The ink “disappears” 
when the form is put through the OCR reader. We have modified CMS 1500 box 31 for 
CT & WA to move the provider’s name one line down after OCR issues were brought to 
our attention today. We don’t understand why such issues should exist (they shouldn’t), 
but have made changes regardless. 

 
March 24, 2008 

• With regard to Scheduler updates 3/19/2008 & later: double-clicking the Views tab 
using the new mode could generate incorrect messages with regard to provider 
availability. 

 
March 22, 2008 

• Updated the Scheduler to include a checkbox on the Views tab. The new checkbox 
allows changes from 3/19/2008 to be applied at will using your configuration settings as 
the default. 

• Updated accounts database to handle ordering provider assignments (from the referral 
database). This data can be assigned during service editing and is included in ANSI 
electronic claim submissions, and uses the ID specified in the payer data for referrals. 

 
March 20, 2008 

• Select Insert body part text into my note from the I want to… button in the patient’s 
SOAP note to launch a pop-up diagram with menus, click on parts, and memory of prior 
selections. 

• Select Add/update condition/exam info from the I want to… button in the patient’s 
SOAP note to manually launch the automatic pop-up dialog for condition related SOAP 
information (which can be retrieved, added, and updated). 

• Some right-click menu options in the Scheduler were affected by 3/19/2008 changes. 
This has been corrected. 

 
March 19, 2008 

• A new view has been added to the Scheduler. Currently, the Week of grid on the Views 
tab displays one column for each day of the week. If multiple appointments exist for a 
specific time (e.g. 10am on Monday), multiple rows are displayed for 10am. This allows 
time intervals for the entire week to be compared quickly. The alternate view we’ve 
implemented works as follows: 



o Only 1 row appears for a given appointment time. Appointments on the same 
time & date are displayed as multiple columns. Thus, a wider range of times can 
be viewed simultaneously for a specific day. 

o This view minimizes vertical scrolling. However, horizontal scrolling will 
increase in order to compare days of the week. 

o This view must be turned on from the Configuration dialog’s Appointments 
tab. Make the appropriate selection from the Files | Utilities | Configuration 
menu. 

o Within the Appointment scheduler startup & performance enhancements box, 
check Alternate week view: one row per time slot. 

o This option cannot be used with the Limit views to selected date (instead of week) 
to enhance performance option. If this option is selected, though data will only 
appear for the selected date, columns will be displayed for each day of the week. 

• The vendor that supplies the technologies used for print previews, form creation, and 
annotations has supplied updates which seem to have addressed a variety of issues. 

 
March 13, 2008 

• Updated ANSI 837 problem introduced 3/12/2008. 
• Fixed anomaly that in rare but varied circumstances could affect a line item statistics 

calculation by not assigning the 1st credit entry linked to a specific service. 
 
March 12, 2008 

• Reversed “print capture” changes made 3/3/2008.  
 
March 7, 2007 

• Internal updates for secondary electronic billing via ANSI 837. 
• Updated CPT database Copy button to properly handle new list-based checkboxes during 

use. 
• Updated Billing / Managed Care Profiles & Claim Authorization Check report. Each 

profile’s Managed Care tab has a new field to enter a $$ amount. When an authorization 
is set for a maximum $$ amount, and the remaining charges are within the profile’s 
setting, it will appear on the report. For example, Jane Doe has a $1000.00 max 
authorization and has already used up $900 of this amount. If the profile amount is set to 
$100 or more, this authorization will appear on the report. 

• Though an unlikely scenario, patients added without any Condition info could cause a 
program crash during data retrieval (e.g. group billing or from rolodex) after updates 
made to the Alert features on 12/17/2007. This has been corrected and has not been 
reported/experienced by any client. 

• Added two new variables to add visit counts to form letters & templates. As always, these 
variables can be selected from dropdown lists as you create form letters or form 
templates. 

o PatientCalculated->VisitCountCurrentYearByAssignedProviderDegree uses 
the assigned provider’s degree type to caclulate total visits for the current 
calendar year. 

o PatientCalculated->VisitCountTotalByAssignedProviderDegree uses the 
assigned provider’s degree type to caclulate total visits for the current case. 

 
March 3, 2008 

• Updated CMS 1500 08/05 “print capture” version to populate box 19 in the same manner 
as the 12/90 version. 



• On 1/28/08, a new data filter was added; the filter title text that prints on report headers 
was affected, potentially generating inaccurate text (even though the correct filter was in 
use). 

• Updated appointment scheduler next/prev button operation (added 2/6/08) when the By 
Provider tab is being viewed 

 
March 1, 2008 

• UB-04 changes for fields 50 & 51. 
• Added provider type “PIN” for automated forms processing. 

 
February 27, 2008 

• Added a new override to each payer. If a provider has an EIN (employer id#) and SS# 
(social security #), ECLIPSE defaults to the EIN for CMS 1500 box 25. You can now 
override this on a payer by payer basis. 

• Printouts of the referral database now include NPI values. 
 
February 20, 2008 

• Printing a group run of form letters works fine. Printing a 2nd group run from the same 
screen does nothing. This has been corrected. 

• Removed debugging code from 2/15/2008 ANSI changes. 
• Updated ANSI 837 Institutional entity type handling. 

 
February 19, 2008 

• The display/print options from the patient folder’s Appointment tab have been extended 
to include missed appointments only. 

• Codes in the CPT database can now be marked as inactive. Inactive codes are still 
available for editing/billing/etc. but do not appear on selection lists (e.g. daysheet/SOAP). 

 
February 15, 2008 

• Modified institutional electronic format ANSI 837I: if no admission date, leave data out. 
• Added a new report for referral options added 2/8/2008. The new referral report tracks 

outstanding but expected reports from providers to whom you have referred patients. 
After selecting Referral Options from the Reports menu, select Outstanding patient 
reports from providers we refer to. 

 
February 12, 2008 

• Added standard & payer adjustment types to daysheet report changes made 2/11/2008. 
• Changes to flat file format (“print capture”) to match 17a of printed CMS 1500. 
• CMS 1500 box 32a/b modified for CA NHIC Medicare. 
• A new default index has been added for the provider database. In addition to the ID & 

name indexes, you can now mark providers as inactive to exclude them from a third 
index which includes only active providers in alphabetical order. Your provider data will 
be converted automatically when you install the update. Make sure you have a valid 
backup. You will be prompted to validate that a backup exists. 

 
February 11, 2008 

• The daysheet report options have been revised. You can now filter this report by both 
ECLIPSE & user defined types. For example… you can include just services and credit 
card payments. 

• When multiple schedules are in use, changing the assigned provider now changes the title 
tab to the provider’s name. 



• We are in the process of updating history (i.e. audit) data to include the primary payer 
when bills are generated (new or copies). 

 
February 9, 2008 

• Addendum to 1/31/2008 NF-3 changes: Up to 55 services can now be included on a 
single bill. 

 
February 8, 2008 

• Within the patient’s EHR tab, the History tab currently has grids for Allergies, 
Immunizations, Medications, and Vitals. A new Referral grid has been added to track 
outgoing referrals. It tracks the date the patient was referred, to whom the referral was 
made (in the same database as your referral sources), whether or not a report is expected, 
the date a report was received, diagnosis, and comments. A new reporting option will 
soon be available to track outstanding reports from providers who received referrals. 

• New scheduler buttons added 2/6/2008 worked fine in Vista but had problems with other 
OS versions. This has been corrected. 

 
February 6, 2008 

• Added two new buttons next to the scheduler’s dropdown calendar. The Previous & 
Next buttons (left & right arrows respectively) take you to either the prior or next day or 
week – depending on your current view. 

• EPSDT information for any service can now be added/edited. This information will be 
included in box 24H of the CMS 1500 form. 

 
February 1, 2008 

• Updated Billing Preview report to include service by service diagnostic links to ICD 
codes. 

• Updated Billing Profiles to allow automatic appointment text / background color 
assignment during scheduling. The background color setting will override the Provider 
background color setting. 

o Applying this setting is equivalent to selecting the color at the time the 
appointment is scheduled. 

o It has no effect on prior appointments scheduled for patient with this profile. 
 
January 31, 2008 

• Default scans now initialize to 300 dpi instead of 200 dpi by user request. Though this 
option uses more disk space, the amount becomes negligible when compared with how 
hard disk size has changed over the past 7 years since the 200dpi option was set as the 
default. 

• EFT check added 1/17/2008 has been modified so the manual override is only functional 
for credit card, check, and payer payments. 

• Removed pop-up message when deleting multiple alerts. 
• Updated 3 page NY NF-3 billing form at client request. If more than 5 services are billed, 

a 4th page will now print (instead of another 3 page bill). As many as 16 services can now 
be submitted on one NF-3 bill. The 4th page is simply formatted to print the attached 
services as per box 15. As always, we recommend that you use the built-in, single page, 
non-billing NF-3 form. Note that we would be happy to entertain requests to convert the 
single page form to include a second page with attached services in a similar manner. 

 
January 30, 2008 

• ECLIPSE automatically stamps the name & date of a document during printing. These 
page stamps have been removed following client request. 



• Printing multi-page documents generated the 1st page only. This has been corrected. 
 
January 25, 2008 

• Added a new filter for policy#. This allows a relatively quick search to isolate a specific 
patient when, for example, a payer only provides minimal identifying information on an 
EOB (the claim authorization & phone filters provide similar capabilities). 

• A new checkbox has been added to the deposit slip to allow inclusion of EFT designated 
payments. 

 
January 21, 2008 

• Patient age (in years only) now shows on Personal tab next to date of birth. 
 
January 17, 2008 

• Multiple changes have been made with regard to remittance processing: 
o Payments declared as ACH – which means claims have been paid electronically – 

are now marked internally as EFT as the payments are processed. These 
payments will not appear on deposit slips. “EFT” will be noted in the check# 
column on the ledger. 

o The report has been updated to display the HIC#. It’s also been updated to 
display more characters on each line for longer error messages. 

• Updated appointment template “Width” values to default to Standard. 
• Payments can also (see above) be marked as EFT (Electronic Funds Transfer) when 

editing a payment or adding a bulk payment. 
 
January 15, 2008 

• Updated ANSI secondary billing to include payment data for $0.00 amounts if 
applicable.  

 
January 12, 2008 

• Fixed issue retrieving patient when Document Search report displayed alternate ID#’s.  
 
January 11, 2008 

• Further changes to the Pending Documents & Document Search reports ensure that the 
highlighted document in the patient’s EHR tab is visible, as well as highlighted. 

 
January 10, 2008 

• A problem with the document types filter in the Document Search report added 1/9/2008 
was fixed. 

• The Pending Documents & Document Search reports have been modified. Originally, 
double-clicking a row in each report launched the patient folder with the EHR tab 
selected. Both reports now also highlight the selected document on the patient’s folder. 

 
January 9, 2008 

• A new EHR report (Document Search) has been added to the EHR section of the 
Reports tree. Comprehensive filtering allows you to use a variety of selection criteria to 
view an interactive report of documents. Simply double click on a report row to launch 
the patient folder [that contains the document] with the EHR tab displayed. 

• NC Medicaid CMS 1500 box 33B: Removed taxonomy code / ID to allow standard 
provider ID to print with 1D. 

• The new Pending Documents report showed “Last edited by” information in the 
“Created by” column. This has been corrected. 

• Displaying image windows inadvertently changed the title of the patient rolodex tab. 



 
January 3, 2008 

• Changes made 11/30/2007 left a frequently used button to appear intermittently on the I 
want to… menu. The Select an additional body part option now appears properly. 

• Changes for ANSI secondary billing (837 format) affect ANSI remittance (835 format) 
import. 

• Changes for ANSI institutional claims to include the provider NPI at the claim level 
(2310A). 

• CMS 1500 form, box 12: NY Medicare patients now display patient start date. 
 
December 19, 2007 

• You can now view all contact info (e.g. all phone #’s, email addresses, etc.) for an 
existing patient directly from the scheduler without retrieving the patient’s folder. When 
you right click your mouse over the patient’s appointment in the grid, select View patient 
contact info from the menu. 

• ECLIPSE automatically checks electronic claims for various anomalies. The check to 
determine if you’ve inadvertently placed the same ID# in the policy & group # fields has 
been relaxed for worker’s compensation claims.  

• The Alert! features have been modified to allow recurring alerts that appear at fixed 
intervals: 

o Patient alerts can be created to recur based on the current condition visit count. 
Thus, if you set the amount to 3, the reminder will only display on every 3rd visit 
(e.g. 3, 6, 9, etc). 

o System & users alerts can be created to recur on a certain day of the month. Thus, 
a specific reminder can be set to always display on the 1st of the month. Note that 
if the 1st falls on a day when the office isn’t open (e.g. a Sunday), the alert will be 
displayed on the next possible day (e.g. Tuesday) that the office is open for 
business. 

• Added new variable for forms / form letters, etc. to automatically place “him” or “her” in 
text. This variable is PatientCalculated->HimHer and is accessible from dropdown lists 
in the same manner as all the other variables that can be embedded in text. 

 
December 11, 2007 

• A new “right-click” menu is now available on all rolodexes to allow tablet users to zero-
in on patients w/o a keyboard. 

• EHR: When you select View attached document file info from the Options for selected 
document… button menu on a patient’s EHR tab, the document’s history is displayed. 

 
December 6, 2007 

• On 11/30/2007, a new option was added to the S.O.A.P. to allow quick review of the last 
note. This capability has now been extended. During viewing, a Previous Note button 
allows you to instantly go back as many notes as you need. 

 
December 4, 2007 

• Modified new button type added 11/30/2007 to show disabled menu selections as grayed 
out rather than omit them from the menu. 

 
December 3, 2007 

• Multi page TIF documents weren’t displaying the current page #. 
• The alert report was modified to include ID#’s when a patient assignment exists. 

 
November 30, 2007 



• A new type of button has been added to ECLIPSE to help alleviate crowding. The new 
button has a downward facing arrow on the right button edge. When you click on the 
button, a menu appears. Move your mouse to your selection & release it or simply click 
again on the menu item to select it. This button type has already been added to the patient 
EHR tab & the EHR SOAP tab. 

• Two new options have been added to the new SOAP documentation: 
o Select Review the last SOAP from the I want to… button menu to review your 

last entry w/o retrieving it from the EHR tab. 
o If you have a pen-based tablet, select Sign the note from the I want to… button 

menu to digitally sign it. 
 
November 28, 2007 

• A new menu option has been added to import EHR data in a ChartSentry™ export file. 
• When paper bills are manually filtered to include a subset of the original charges, if 

payments were printed (this is an option), they were printed based on the bill – not on a 
line item basis. ECLIPSE now attempts to determine & include payments as they pertain 
to the partial, itemized bill. It will match line item entries if you’ve created them. 
Otherwise, it will try to match payments by service date. 

• The ability to designate a non-covered amount for each CPT code was added in January, 
2005. In some situations, using such amounts in combination with deductibles could 
result in an inaccurate patient responsibility determination. 

 
November 21, 2007 

• Locked update for CD distribution. 
• CMS 1450 / UB04: Added Document Control Number (field 64). A DCN provided by 

the payer following bill submission can be entered by pressing the UB04 / Medicaid 
button when editing a bill. 

 
November 14, 2007 

• Internal changes to an existing configuration tab (which simply made the tab title longer) 
caused Windows to – in some situations – fail to display some tabs.  

• Automatic export of patient data for various interfaces had an issue introduced 
11/24/2006 which failed to separate case ID’s from descriptions. This has been corrected 
to conform to our original published specifications. 

 
November 7, 2007 

• The EHR SOAP documentation has been enhanced to illuminate the path to prior 
selections by placing green checkmark icons at appropriate points in the selection tree. 

• Physical Therapy S.O.A.P. evaluations are ready to begin testing.  New features include: 
o A pop-up body part diagram specific for PT verbiage allows users to select 

wording (e.g. left posterior proximal calf) from either a diagram, menus, or by 
typing... 

 Multiple body parts can be selected & added to a list before adding the 
group of parts to the note. 

 During note creation, this diagram retains all prior choices and allows 
you to re-select any or all later in the note by simply checking them off 
on the list when the diagram appears. 

o Tree items can now be classified as subjective, subjective primary complaint, 
objective, and tests. Your choices are then pulled up later in the note as required 
so you can select from a list (e.g. all muscle tests that weren’t 5’s). 

 
November 5, 2007 



• Updated CMS 1500 box 13 to default to “Signature on file” instead of “Authorization on 
file.” 

 
November 1, 2007 

• When your default patient screen was the patient’s Condition tab, changes made 
6/26/2007 could create a problem with PI/Comp/State data – which didn’t appear for the 
most recent condition & could be erased if you saved patient data after being prompted 
that changes had been made. This has been corrected. 

 
October 30, 2007 

• EHR enhancements allow a SOAP template that doesn’t contain image coordinates to be 
used as the main template. ECLIPSE checks for coordinates automatically & determined 
whether or not to display the entire template or the selection diagram. 

• Electronic remittance (ANSI 835) updates include: 
o Some payers seem to have ignored government mandated specifications when 

handling “charge backs.” ECLIPSE now corrects for this behavior. 
o When a remittance file included multiple payers, ECLIPSE failed to recognize 

additional payers. This has been corrected. 
 
October 22, 2007 

• Printed fee slips are automatically reconciled with daysheet entries. Depending on the 
type of fee slips printed however (i.e. custom, custom PDF, or standard) this feature 
didn’t work correctly. 

• Updated electronic remittance routines to handle negative $$ amounts. 
• Updated EOB button to allow manual entry of $0 CAS & AMT codes. 

 
October 15, 2007 

• CMS 1500 box 32b changes for MN BC/BS. 
 
October 13, 2007 

• When adding a new Condition & responding “Yes” to the Copy? question, subsequent to 
Condition changes from 6/26/07, it appeared as though existing PI/Comp data was copied 
too. This has been corrected. PI/Comp data can be copied separately (as always) by using 
the right-click menu. 

 
October 10, 2007 

• Updated changes from 9/14/2007 to handle an issue that disallowed changing new 
provider ID#’s [before the new info is saved] after using the Copy button. 

 
October 9, 2007 

• For safety reasons, ECLIPSE automatically prevents multiple users from updating the 
same data simultaneously. Though we haven’t encountered a [reported] problem in any 
offices, HELP Desk testing located a potential issue in Microsoft Vista that affects proper 
ECLIPSE functionality. This ECLIPSE release contains updated FairCom libraries to 
work around the issue. Vista users must also obtain and load a Microsoft HotFix related 
to Microsoft KnowledgeBase article 935366 on each PC running the Vista operating 
system.  This HotFix will be installed on your system automatically. 

• The Birthday List report has been extended to allow patients with a “DO NOT PRINT”  
mailing label status to be optionally excluded. 
 

October 4, 2007 



• Removed “test” message inadvertently left in 9/26 program that might appear during 
CMS form printing. 

 
September 29, 2007 

• The patient’s Add services/credits dialog can now be manually resized. This allows 
expansion of some of the windows so more data can be viewed without scrolling. 

 
September 26, 2007 

• CMS 1500 box 6 change for NY when Medicare is secondary. 
 
September 20, 2007 

• The scroll wheel on a mouse can now be used to navigate rolodexes (patients, attorneys, 
etc.). 

• CMS 1500 box 12 & 13 changes for MN. 
• CMS 1500 box 24H change for VT Medicaid. 

 
September 18, 2007 

• Information can be copied to the Windows clipboard by pressing Print on the patient’s 
ledger tab & selecting the Clipboard tab. A new checkbox has been added to export the 
patient’s next appointment. 

• During ANSI 837 electronic billing, global remittance overrides added in March, 2005 
are now applied just as they have been for printed CMS 1500 forms. 

• CMS 1500 box 21:  ICD’s 1&2 were realigned one character to the left. 
• EHR tab now scrolls to & highlights the most recent entry. 

 
September 14, 2007 

• CMS 1500 changes for FL Medicaid boxes 24 & 33. 
• CMS 1500 changes for NY Medicare box 13. 
• In order to avoid errors created when users change ID#’s (e.g. for a payer) and then 

erroneously save the updated data, ID#’s for the following database files can no longer be 
edited after the initial record is added: attorneys, billing profiles, employers, facilities, 
guarantors, payers, pharmacies, providers, and referral sources. 

• You can now print fee slips individually from the scheduler by highlighting an 
appointment cell, right-clicking your mouse for the menu, and selecting Print Fee Slip.  

• Users can now be logged off automatically according to a time interval defined by the 
System Administrator.  The Sys Admin can also determine whether the user is simply 
logged out (ECLIPSE is still running) or the session is completely terminated. The Sys 
Admin can change these settings by selecting Database Tables from the File menu, and 
then selecting Users from the menu tree. What’s the purpose of this new feature? 

o Users may have [HIPAA related] security concerns. 
o Automatic late night backups may be hindered by users who fail to exit the 

program at their workstations during the day. 
 
September 10, 2007 

• The PDF Form Designer menu has options which allow pages to be added, inserted, 
deleted, and duplicated. Version 10 inadvertently disabled these options. 

• Minimization workarounds added 7/25/2007 have been modified in an effort to better 
tune them to work properly in all situations. ECLIPSE might have inadvertently 
maximized when a different icon was clicked on the task bar. 

• During service entry, the Current status window displays a variety of information. In 
order to improve readability, owed amounts are now displayed in bold & deductible 
amounts are displayed in red. 



 
September 7, 2007 

• ANSI 837 change for electronic billing affects loop 2310D, for treating facility NPI 
submission. 

 
September 6, 2007 

• Added service line PIN override for NY Worker’s Comp provider/payer billing ID’s. 
 
September 5, 2007 

• Added an optional date range to the accounts receivables report. This allows you to 
restrict the report to bills created during the date range that match your criteria. 

• On the Guarantor’s Policy & Coverage tab, added “None” as a Medicare Secondary 
option.  

 
August 31, 2007 

• When the treating provider is manually changed during service entry, it is now updated 
for an attached adjustment automatically. 

 
August 27, 2007 

• CMS 1500 change for box 11 in MN for Medicare secondary billing. 
 
August 21, 2007 

• CMS 1450 changes for rows 50 A,B,C & 58 A,B,C for secondary billing. 
 
August 15, 2007 

• Corrected claim form authorization issues with regard to sorting provider degree types 
prior to selecting the appropriate authorization. 

• CMS 1500 box 11 changes for MA. 
 
August 14, 2007 

• Internal handling of condition data (diagnoses, Worker’s Comp data, etc) has been 
rewritten to accommodate some third party data conversions. This only affected patients 
added to ECLIPSE with no diagnostic information during data conversion from other 
practice management systems. 

• Fix for changes made 6/27/2007: Fee slips or other PDF forms printed in bulk from the 
Reports menu did not accurately reflect diagnostic information.  

 
August 10, 2007 

• More changes (see 8/7/2007 entries) for audit reports. ECLIPSE now tracks each time an 
ANSI 837 file is generated. 

• 6:30pm: Changes to receipt printing additions from 8/9. 
• 6:30pm: Changes to CMS 1500 box 19 alignment for NC. 

 
August 9, 2007 

• Receipt printing: Optionally restrict balance to amount owed by patient for displayed 
case. Optionally exclude payer credits.  

 
August 7, 2007 

• ANSI 835 remittance AMT segment handling implemented 7/19/2007 wasn’t saving the 
imported AMT segments. Data is now imported from 835 files, saved, and exported out 
to 837 files during secondary billing. 



• Added a utility (which must be run by calling the HELP Desk) to create duplicate PI & 
Worker’s Comp records for each patient condition.  

 
August 6, 2007 

• Updated audit data to differentiate between paper & electronically generated bills and to 
track new bills. This now allows for comprehensive audit tracking & reports of originals, 
copies, and secondaries via both print & EDI (Electronic Data Interchange). These 
changes are available: 

o On the User Audit report… Click on the Reports menu, select Audit from the 
Reports tree, and click on User Audit. 

o From the patient’s Ledger tab… Press the Print button and select the History 
page. 

o From the patient’s Ledger tab… In the Bills grid, Press the Open button in the 
History column of any bill row. 

• Statistics reports for the office now always reflect the clinic name field. 
• Updated changes made 7/30/2007 to avoid generating error messages for $0 claims 

during a group billing run. 
• Updated NY C4 versions to override Provider ID’s with older ZIP code overrides after 

4/19/2007 changes. 
• CMS 1500 box 26 & 33 changes for MN BCBS. 

 
August 3, 2007 

• CMS 1500 box 17A/24J changes for MI BC/BS. 
• After changes on 7/26/2007, if you added a new case, the new case’s condition data was 

not saved with the new case information. 
 
July 30, 2007 

• Guarantor termination dates (when you use them) are now checked against condition 
dates. If an error is encountered, a new error message is generated and the bill is not 
created. 

• A progress bar has been added to service imports. 
• The disk space viewer displayed file sizes larger than 2 GB as negative values because of 

an overflow condition.  
• Updated SOAP templates. 

 
July 29, 2007 

• Fixed SRS interface for clients using SRS products. 
 
July 27, 2007 

• Authorizations: When adding new or deleting existing authorizations, the displayed list 
didn’t update as expected. 

 
July 25, 2007 

• CMS 1500 box 33B changes for FL Medicaid 
• An unknown anomaly in Windows caused problems when trying to restore ECLIPSE 

after having minimized it. A workaround has been developed which seems to handle this 
issue. 

• Billing forms (e.g. NY C-4) that utilized PI, Comp, or State data printed correctly 
individually, but not in group runs. This has been corrected. 

 
July 20, 2007 



• A problem exists with requested feature changes on 6/26/2007 that re-assigned PI, 
Worker’s Comp, and special state data to conditions. Data entered during new patient 
entry was not saved. This has been corrected. 

• Password protection changes for generated PDF documents. 
 
July 19, 2007 

• On 4/2/2007, we added the ability to manually enter or automatically import CAS 
(adjustment information) from your ANSI 835 EOB’s. We have now added the ability to 
process related AMT (payment information) such as allowed amounts – which may be 
required for secondary claims processing. Though these codes are now imported 
automatically during 835 processing, they can also be viewed or entered manually from 
an EOB by editing an individual service and pressing the EOB button in the lower right 
hand corner of the dialog. 

• Adjusted vertical alignment for page 2 of the NY NF3 form. 
 
July 16, 2007 

• CMS 1500 box 33 updated for TN phone # inclusion. 
• CMS 1500 flat file box 33b. Added spacing to group ID#’s & qualifiers for consistency 

with other flat file PIN’s. 
 
July 9, 2007 

• Bulk email capabilities have now been added to one of the Appointment Recall reports. 
Select Print / Email form letters to send form letters via email to patients that meet your 
recall criteria. 

 
July 5, 2007 

• New email capabilities! 
o ECLIPSE can now send bulk email. In order to show off these new features, bulk 

email has been implemented first in Reports | Form Letters. Thus, you can now 
send existing form letters that you might otherwise print via email.  

o Each email is automatically formatted as both plain & HTML text. So, if you 
created a form letter in color using a variety of fonts, your patient’s email 
software will determine what is displayed. Embedded graphics are not currently 
supported. 

o Sending email now requires permission. Select Database Tables from the File 
menu & Users from the tree to update permissions. Email permission is under 
Global Permits. 

o In order to use these new capabilities, you must update information in two 
different places in ECLIPSE. 

 From the File | Utilities menu, select either System or Workstation as 
appropriate. Select the Import/Export tab. New email fields must be 
filled in. You can obtain this information from the account settings in 
your current email program or by contacting your internet services 
provider. For example, in Microsoft Outlook 2003, select Email 
Accounts from the Tools menu, follow the wizard to view or change 
existing settings, and select Change to view your POP3 & SMTP 
servers. 

 Select Database Tables from the File menu & Users from the tree to 
update user information. Each user’s Email tab now has information 
fields which you may or may not want or need. The return address is an 
optional override. Email user name & password settings are dependent 
on your internet services provider. 



o The new email features will be extended shortly to other areas such as 
appointments to allow reminders, etc. 

 
June 26, 2007 

• By request, extensive internal modifications now associate Worker’s Comp, Personal 
Injury, and State based data with a patient’s Condition. Previously, this data was 
associated with the Case, and only one copy of the data was possible within the case. 
Data can still be copied between cases & conditions, but will not copy automatically 
when a new Condition is created.  

o The PI/Comp/State tab has been moved from the patient folder to the 
Condition tab. Also, the old (separate) permissions no longer apply. The 
Condition permissions are now applied to this information. 

o When you launch this update, you will be independently advised to rebuild 
indexes for each of the three types of data mentioned above. You must select 
“Yes” to continue program operation. Make sure you have a good backup.  For 
the vast majority of users, this process should take seconds. 

o Existing data will now be associated with the condition you assigned it to. If you 
use generic (i.e. no services appear on the form) copies of the forms in CA, MA, 
NJ, NY, etc. it’s not necessary that the data appear on the current condition. 
When you print a form, ECLIPSE will always seek the data associated with the 
most current condition (whether it’s 1 or 15) assigned to the patient case. 

o For NY C-4 & NF-3 forms which print services directly on the bill, if you have 
not maintained an association with the current condition on the patient’s WC or 
PI data, you must manually copy the data from the associated condition 
(probably 1) by right clicking the grid and using the available menu operations. 

o By request, default settings for new Worker’s Comp data have been updated as 
follows: Is patient disabled? is initialized to Yes. Was the occurrence described 
the competent cause of injury? is initialized to Yes. 

• Modified first referral report to calculate totals based on all services rather than case 
totals only. 

• CMS 1500 changes for OH Medicare box 11. 
 
June 23, 2007 

• CMS 1500 changes for MN BC/BS box 33b. 
• CMS 1500 changes for  KS Medicare box 10b. 
• Fixed FL Medicaid change made 6/19 which adversely affected CMS 1500 box 24e. 

 
June 20, 2007 

• Internal EHR S.O.A.P. enhancements for better cohesion of automated singular/plural 
choices during S.O.A.P. entry. 

 
June 19, 2007 

• Updated “print capture” of CMS 08/05 form to more closely mirror PIN assignment for 
printed CMS 1500 box 33b. 

• CMS 1500 changes for IA Medicaid box 33b. 
• CMS changes for FL Medicaid box 24E. 
• Reinstated IL Medicaid form removed 5/4/2007. 
• S.O.A.P database updates & additions. 

 
June 16, 2007 

• If you use the Global Remittance Override in the Configuration & direct bill 
electronically using the ANSI 837 (HIPAA compliant) format, you will need to check 



your settings after installing this update. This update should not affect your CMS billing 
forms. 

o New fields have been added to allow entry of a remit-to provider first & last 
name, along with an entity type to identify the provider as a person or 
organization. 

o Select System or Workstation (as appropriate) from the File | Utilities | 
Configuration menu. Select the Data Defaults tab to view/edit your Global 
Remittance Override settings. 

 
June 15, 2007 

• Changes made 6/13 affected instant inclusion of new EHR documents on the displayed 
list. 

• Removed minimization changes added 6/8/2007 (by request). 
• The first Referral report option: List Report Referral w/patient referral source (by patient 

ID#) did not always group all possible referral sources together. 
• ANSI 837 changes to remittance overrides. 

 
June 14, 2007 

• Offices using global remittance overrides with 6/13/2007 changes could experience 
unwanted first names appearing on printed bills in the pay-to areas (e.g. box 33 on the 
CMS 1500 form). 

• Changes for CMS 1500/ANSI 837/print capture. 
 
June 13, 2007 

• Added a first name to Global Remittance Override configuration data for ANSI electronic 
billing. ECLIPSE will automatically check whether you’re using both (first & last name) 
fields as well as whether they contain identical information prior to printing. 

• Changes made 5/1/2007 for MN BC/BS were propagated to the pre-printed CMS 1500 
form. 

• Patient EHR History tab: It was possible to add multiple copies of new entries if the 
Save Changes button was pressed multiple times. This has been corrected. 

 
June 9, 2007 

• To further enhance capabilities added 6/7/2007, when EHR documents are generated as a 
group, Microsoft WORD documents are now generated w/o using WORD. This allows 
them to be included in a single master document & saved as a PDF. Note that this may 
cause problems with some DOC file versions. If you have a problem, convert your 
WORD files to PDF before importing them to ECLIPSE. 

 
June 8, 2007 

• MA Medicaid form #9: updated boxes 1C & 1D. 
• ECLIPSE now minimizes directly to the System tray. It will no longer appear on the Task 

Bar once it’s minimized. Simply pass your mouse pointer over the tray icon & it will be 
restored to its former position. The first time any user minimizes ECLIPSE, a reminder 
should appear. 

 
June 7, 2007 

• You can now print any combination of documents in a patient’s EHR by date range. 
Press Print on the patient’s Ledger tab & select the EHR tab. Your document types 
appear in a checklist box along with S.O.A.P & Notes selections.  Note the following: 

o If you have a fax modem installed, you can send the documents directly to the 
fax. 



o If you use the Preview/Print feature, you can save all the documents to a single 
PDF and email it. 

o At this time, imported WORD documents can only be sent to the default printer. 
• When you save or email a document generated with Preview/Print, you will be 

prompted to create a password for the document. Press Cancel to leave the document 
unprotected.  

• The NY C-4 form has been modified to allow payer overrides such as Print assigned 
facility on form to override information in box 22. 

• CMS 1500 box 32b has been moved 1 character to the left top accommodate 14 character 
ID#’s. 

 
June 4, 2007 

• New data items added to Vitals. This data has now been linked with the SOAP templates. 
It can be added or updated, or retrieved during SOAP entry. 

 
June 3, 2007 

• New patient Vitals grid added 5/24 to the EHR’s History tab has been integrated with 
the new S.O.A.P. for automatic incorporation in templates. Most recent height, BP, 
weight, etc. can be added to current note or new information can be added directly to 
database during S.O.A.P. entry. 

 
May 29, 2007 

• Added an override to each payer to allow individual override of CMS mandated “NPI 
only” dates. 

 
May 28, 2007 

• Replaced MA Medicaid #9 form with 03/07 revision that includes NPI. 
• Added Quick Notes to batch export utility (to export all ECLIPSE patients). Select 

QuickNotes from the dropdown list after selecting Third Party Formats from the File | 
Data Import / Export | Export menu. 

 
May 25, 2007 

• If you are adding services during S.O.A.P. entry, ECLIPSE will now process the Launch 
editor when selected during service entry option on the CPT General tab. This allows 
you to edit services as you enter them without using the ledger. 

 
May 24, 2007 

• Removed all data suppressors from flat file 08/05 data. 
• The patient’s EHR tab contains two tabs: General & History. The History tab has grids 

for Allergies, Immunizations, and Medications. A new tab has been added for Vitals. 
This new tab allows entries for height, weight, left & right blood pressure, active & 
resting pulse, and body temperature. This data will also be integrated into SOAP 
templates that are currently in production. 

 
May 23, 2007 

• CMS 1500 changes for FL & MN Medicaid. 
• CMS 1500 changes for IA Medicaid. 

 
May 22, 2007 

• ANSI Institutional changes for secondary billing. 
 
May 21, 2007 



• CMS 1500 boxes 24A & 31 for NY Empire Medicare. Override CMS guidelines by 
selecting Print dates as MMDDCCYY  (no spaces) in box 24 of the 12/90 or 24/31 of the  
08/05 form from the Printed Claim Options tab. 

• Added patient’s middle initial to rolodex. 
• ANSI 837 change for IL Medicaid acquisition. 

 
May 17, 2007 

• ANSI 837 changes for Preferred Care of NY. 
 
May 16, 2007 

• Removed UB-92 form (current form is UB-04). 
 
May 15, 2007 

• Fixed scheduler problem with blocked time intervals that only partially overlapped an 
appointment. 

• Currently, ECLIPSE allows for a maximum of 15 user-defined adjustment & credit types. 
This has been extended to 25. 

• CMS 1500 box 1 alignment changes. 
• ANSI 837 changes for secondary billing. 

 
May 14, 2007 

• CMS 1500 08/05 form now incorporates the same height font as the older 12/90 form. 
 
May 11, 2007 

• Internal ANSI 837 changes from 5/4/2007 could affect how group/individual providers 
were added to ANSI 837 file. 

• Propagated 4/3/2007 CA Box 31 changes for CA to flat file for “print capture.” 
• ANSI 837P changes. 

 
May 10, 2007 

• CMS 1500 changes for NY Medicare. 
 
May 9, 2007 

• Updated referral reports to allow a date range to be set for services & payments.  
 
May 8, 2007 

• Updated claim authorization report to provide more information & include all active 
authorizations for the current condition. 

 
May 7, 2007 

• The Taxonomy PIN type added 4/18/2007 was not showing up as a PIN type in the 
dropdown selection box. 

 
May 4, 2007 

• CMS 1500 changes for NC Medicaid. 
• Removed HCFA 1500 1980 & 1984 form versions. Removed IL Medicaid form. 

 
May 3, 2007 

• The buttons to insert periods & commas for the Patient folder’s legacy S.O.A.P. tab 
failed to insert expected text. 

• Printing legacy S.O.A.P. notes could intermittently result in a prompt to save the 
document. This has been corrected. 



• Multi-database versions of ECLIPSE using PDF form templates had problems retrieving 
form templates after additional code was added to help support technicians determine 
path information for the assigned template.  

• Opening PDF form templates for editing in a multi-database version of ECLIPSE now 
defaults to the local database version of the folder. 

• In the patient’s EHR folder, document import is now available in all versions of 
ECLIPSE. 

 
May 2, 2007 

• Additions to the payer database now allow overrides for individual payers that require 
entity information that differs from the ANSI standard.  

 
May 1, 2007 

• CMS 1500 box 30 changes for MN BC/BS 
• CMS 1500 flat file: Removed box 19 DC specific Medicare data.  
• CMS recently changed the mandatory NPI compliance date from May 23, 2007 to May 

23, 2008. ECLIPSE automatically handled printing older PIN types through this date & 
has now been updated to handle the new compliance date. CMS announced these changes 
on April 4, 2007. 

 
April 30, 2007 

• Repaired several issues related to printing S.O.A.P. created in the EHR. 
• Payer claim options specific to box 24 on the 12/90 form affected the 08/05 form: Print 

dates as MMDDCCYY (no spaces) in box 24 of the 12/90 form.  
• Updated changes for IL BC/BS boxes 24I/24J introduced 4/23/2007. 
• Automatic remittance processing didn’t release locks on patient records. 

 
April 23, 2007 

• CMS 1500 changes for KY Medicaid updated 4/18/2007. Taxonomy code qualifier set to 
“ZZ”. 

• CMS 1500 changes for IL BC/BS boxes 24I/J, 32b & 33b. 
 
April 20, 2007 

• System alerts assigned to a specific user did not appear to be deleted after the deactivate 
box was checked and the Deactivate button was pressed. 

• CMS 1500 changes for OH Medicaid 10D. This data (“other source” as defined by 
Medicaid) must be entered when you edit the bill by pressing the UB-04 / Medicaid 
button. Medicaid expects this information after you have billed all other sources of 
payment for this claim. 

 
April 19, 2007 

• CMS 1500 box 17 & 32 changes. 
 
April 18, 2007 

• Updated Facility database to handle a maximum of 5 PIN types per facility. 
• Reference flat file CMS 1500 additions made 3/19/2007: Column 31 in “box 10D” now 

contains the primary payer ID. 
• CMS 1500 changes for KY Medicaid. A taxonomy code must exist in the provider’s 

record in order to print this information in box 24J. 
• CMS 1500 changes for box 32b qualifier. 
• ANSI 837P changes for IL Medicaid. 



• Updated CMS flat file (“print capture”) 08/05 format to ensure all non-service dates are 
CCYY format. 

• When the scheduler is launched from a patient’s folder and an appointment template is 
retrieved with “New Patient” checked, the appointment was not associated with the 
attached patient. This has been corrected. 

• CMS 1500 change for Medicare box 19 in NM. 
 
April 16, 2007 

• Updated user lists to include each user’s current folder. 
 
April 13, 2007 

• Updated box 17a qualifiers. 
 
April 12, 2007 

• Changes made 11/16/2006 (see first bullet) can affect patient balances during billing 
under specific sets of circumstances that revolve around automatic splitting of credits 
among different bills (if turned on in the configuration). This has been corrected. 
Balances can be globally corrected by selecting Recalculate patient balances from the 
File | Utilities | Repair menu. This feature is best utilized directly on your data server 
when no other users are running ECLIPSE. 

• Updated CMS flat file (“print capture”) 08/05 format to restrict data in box 32 from 
overflowing into box 33. 

 
April 11, 2007 

• Corrected problems with EHR S.O.A.P. pop-ups introduced 4/10/2007. 
 
April 10, 2007 

• Updated EHR S.O.A.P. pop-ups (specifically those with multiple dropdown selection 
boxes) to automatically separate & handle singular & plural selection possibilities. This 
ensures that fewer choices are presented simultaneously. Thus, if you can choose among 
left, right, both, and bilateral and your next set of selections formerly included choices 
such as shoulder & shoulders, this update will automatically relate shoulder to left & 
right and shoulders to bilateral and both. Ultimately, this makes the selection process 
cleaner & faster. 

• ANSI 837 NPI changes for institutional claims. 
• Updated CMS 08/05 flat file created 3/19/2007 for consistency with dates in box 24A/B. 

 
April 6, 2007 

• Fixed ANSI 835 remittance issues introduced 11/21/2006 that affected 835 files created 
with “extra” characters from old style mainframe systems. 

 
April 4, 2007 

• Using the patient tab menu to close a patient’s folder (right-click the tab for the menu) 
could result in multiple folders being closed. 

 
April 3, 2007 

• CMS 1500 08/05: Removed Box 31 CA customization: “Signature On File” 
• Changed wording on patient bill from “Physician” to “Provider.” 
• Updated scheduler so Rolodex gets out of the way if you select New after pressing Select 

Patient. You must press the Select Patient button again after adding the new patient to 
the database. 

 



April 2, 2007 
• Though we have processed ANSI 835 remittance files since inception, optional & 

situational information is only included upon payer request. Billing secondary payers has 
resulted in multiple requests for situational Adjustment Reason Codes from the primary 
carrier to be submitted during secondary billing. These codes are now imported 
automatically during 835 processing. They can also be viewed or entered manually from 
an EOB by editing an individual service and pressing the CAS button in the lower right 
hand corner of the dialog. 

• CMS 1500 08/05: Removed facility PIN overrides in Box 32 for Medicare for KY, IL, & 
WI. 

 
March 28, 2007 

• PDF capabilities updates on 3/23/2007 had errors. Though the software vendor is 
working on these, we believe we have introduced a functional workaround. 

 
March 26, 2007 

• With regard to automated services/charges import, it appears that this feature is no longer 
being implemented or used as we originally intended. In order to handle potential 
interface implementation issues created by third-party products that don’t conform to 
ECLIPSE specifications, service import is now automatically followed by a report if 
errors are found. The report includes information regarding patients whose folders were 
in use at the time services were imported, services that couldn’t be imported because an 
equivalent code could not be located in the ECLIPSE database, and patient ID#’s that 
don’t exist. Any items that appear in the report must be resolved manually. 

• Referral sources now have new fields for degree type & specialty. 
 
March 23, 2007 

• New PDF generating updates have been included in ECLIPSE. Among other resolved 
issues, this should allow documents to be created using landscape mode. Additionally, 
problems with Print/Preview that caused ECLIPSE to “hang” should resolve as well. 
Finally, color documents can optionally be displayed in color by leaving the “force 
monochrome” selection unchecked on the print destination dialog. 

• SOAP data has options which include the ability to delay loading of large subtrees until 
an item is selected. A problem which opened the sub-tree but failed to add the selected 
text to the editor has been resolved. 

• An additional space has been added between PIN qualifiers & PINs as the default for 
CMS 1500 08/05 forms. We currently have conflicting payer information on related 
fields. 

 
March 20, 2007 

• Automatic SOAP item customization was impaired when different custom text prompts 
gathered different information for versions of the same tree item. 

 
March 19, 2007 

• You can now draw diagrams & import images directly into SOAP notes created 
within the EHR. You have control over colors, font sizes, and pen widths. Draw free 
form, add text, create lines, rectangles, and ellipses. You can draw on imported images 
(supplied by us or use your own) and crop the final image before you paste it into your 
note. 

• At the request of third-party clearinghouses that prefer to process electronic claims as 
two-dimensional database “flat” files (commonly referred to as “print capture” files) – 
instead of relying on the more reliable ANSI specifications included in HIPAA – a flat 



file version of the CMS 1500 05/05 form has been created that includes NPI information. 
If you intend to switch to this format: 

o The file type must be changed via the system configuration. 
o DO NOT change the file type until all data currently in the file has been transmitted and the file is 

erased. 
o You must coordinate this process with the clearinghouse or their computers will not recognize your 

files. 
o The first time you send data in the new format, the clearinghouse may need to “map” the data if 

they have not yet received an equivalent file from other ECLIPSE users. 
o The new file uses an 80 line record format. Thus each bill in the file is 80 lines long. 
o This file specification is not yet finalized and is subject to revision over the next few months. 

 
March 15, 2007 

• Changes to CMS 1500 08/05 form boxes 32a/b & 33b at the request of GalacTek. 
• Bill#’s didn’t always appear in various EHR sections (for assignment) during document 

import. 
• ANSI 837P changes for BSBS-Fed 

 
March 13, 2007 

• For CMS 1500 08/05 form: Added spacing in boxes 32b & 33b for Medicare. 
 
March 12, 2007 

• Enabled Daysheet report to exclude the selected user. 
 
March 11, 2007 

• As of October, 2006, a Microsoft security patch disabled network access of “chm” HELP 
files. ECLIPSE has been updated to handle this. 

 
March 5, 2007 

• After opening a form letter, a gray box could obscure the actual type. This has been fixed. 
 
March 2, 2007 

• Your last SOAP note text from the patient’s EHR can now be added directly to a form 
letter with a new variable (PatientCalculated->LastEHRSOAPNoteText) which can be 
dropped into any form letter from the form letter designer. This can be used to send 
documentation to a referring provider. 

 
March 1, 2007 

• UB-04 form is now available. 
 
February 23, 2007 

• The ability to exclude patients with future appointments  from the “Trace Patient Visits” 
report was inoperative in v10 & has been fixed. 

• Modified CMS 1500 08/05 to print one “x” in box 1 instead of double “xx”. 
• ANSI 835 remittance files for multiple providers would display the wrong bill when 

making adjustments after automatic credits were applied. 
 
February 23, 2007 

• Recent NPI changes for CMS 1500 led to potential line of service PIN errors when 
multiple providers appeared on the same bill. 

• CPT edit access in v10 was permitted regardless of permission settings. 
• Locked for v10 CD update. 

. 
February 21, 2007 



• ANSI 837 changes for secondary billing. 
• The patient rolodex required an “activation click” when it became the current tab after a 

previous tab was closed. This extra click is no longer necessary. 
• Closing a patient tab via the right click menu when changes were made closed multiple 

tabs. This has been corrected. 
• Microsoft’s new VISTA operating system does not support the ECLIPSE online HELP. 

HELP has been ported to HTML for VISTA compatibility. 
 
February 15, 2007 

• ANSI 837P changes for MI. 
 
February 10, 2007 

• Some carriers may require a two character qualifier in boxes 17a, 24j, 32b, and 33b of the 
CMS 1500 08/05 form. The Printed Claim Options tab for each payer now offers the 
ability to: Print qualifiers in 17a, 24j, 32b, and 33b on 08/05 form. Since we have little 
data as to what percentage of carriers may require this, it’s OFF by default. 

• Facilities can now be assigned 2 PIN#’s simultaneously. 
 
February 8, 2007 

• Added the ability to exclude a specific provider to the daysheet. 
• CMS 1500 08/05 form: Added payer override so payer name and address can be centered 

at top of form to avoid the space above box 1a. 
 
February 6, 2007 

• CMS 1500 08/05 form: Added new PIN type (Group NPI) to allow a group NPI# to print 
in box 33a. 

 
February 5, 2007 

• CMS 1500 08/05 form changes: As per Medicare Payer Manual, all dates except birth 
dates now use  2 digit years (i.e. MM DD YY) because box 24A cannot handle 4 digit 
years as well as the CMS 1500 12/90 form (space limitations). 

 
February 3, 2007 

• Added configuration abilities to disable legacy Notes & SOAP tabs in patient folder. 
Also, allowed new Welcome screen to be manually disabled for older Windows versions  
that are unable to properly store data in the registry. 

 
January 31, 2007 

• CMS 1500 minor alignment adjustments for preprinted form boxes 7, 11d, 32a, and 33a. 
• Added new totals to List Bills By Date report to display outstanding amounts (based on 

responsibility) for payer & patient. 
 
January 29, 2007 

• Fixed CMS 1500 08/05 alignment (w/o form image) when 1 vs. 6 services printed. 
 
January 27, 2007 

• ANSI 837 fixes for SV1 issues introduced 12/7/2006. 
 
January 21, 2007 

• CMS 1500 08/05 changes for box 32. 
 
January 18, 2007 



• ANSI 837 changes for secondary billing. 
 
January 12, 2007 

• Various CMS 1500 08/05 form changes. 
• Updated all image viewers (scan & display) to render images in a higher quality format. 

Added right-click menu to image preview in patient’s EHR tab. 
• EHR documents can now be marked pending and routed to specific users in the office. 

The Reports menu has a new Pending Documents report under the EHR heading. 
• When you right-click the scheduler and launch a patient, the patient folder now launches 

as a tab. 
 
December 22, 2006 

• Right click on any top-level tab for a menu. Close is now an automatic option. 
• As you zero-in on data (e.g. patients) by typing, sometimes a “beep” will sound. This has 

been eliminated. 
 
December 5, 2006 

• Updated standard ECLIPSE versions to allow condition-based ICD codes assigned 
directly to services to be removed. 

 
November 22, 2006 

• Alerts have been added to the Reports menu. 
 
November 21, 2006 

• Updated ANSI 835 remittance to handle alpha-numeric adjustment reason codes. 
 
November 20, 2006 

• Added back appointment system menu options from v9 to launch calendar & refresh the 
scheduler. Right click the tab to access the menu. 

 
November 17, 2006 

• ANSI 837P changes for UTI in PR. 
 
November 16, 2006 

• Prior versions of ECLIPSE optionally allowed payments to be automatically applied to 
existing bills during service entry. This feature has been extended to include billing. As a 
bill is generated, patient payments within the billing period that exceed patient 
responsibility (for the new bill) will subsequently be applied to the oldest bills first before 
being assigned to bill #0 (i.e. unassigned). Automatically apply open item credits to 
outstanding bills must be enabled in your configuration (File | Utilities | Configuration 
menu) for this to apply. 

• Fixed RTF group form letters for referral thank you’s. 
• Checked List boxes added in v10 (configuration & payer screens thus far) may add 

duplicate checkboxes as you switched back & forth among tabs. 
 
November 15, 2006 

• Adjusted CMS 1500 12/90 form box 25 for BC/BS of MN. 
 
October/November, 2006  **What’s New in v10** 

• Most windows (e.g. document scanner, alerts, patient rolodex, patient folders, 
appointment scheduler) now take up the entire screen as tabs in the main ECLIPSE 



window to ease switching among open windows. Tabs can only be closed from the 
toolbar (fourth tool item from the top).  

• Patient folders in v9 had additional menu items available on the System menu at the 
upper left corner of the folder. These options are now available by right clicking the tab 
at the top of the folder with the patient’s name. 

• The Next Window toolbar button (fifth from the top) has new functionality. When you 
press this button, a dialog appears with a list of open tabs. You have several options: 

o Double click on an item in the list to make that window the active tab. 
o Click on an item & make it the active tab by pressing the OK button. 
o Select one or more tabs in the list and click Close Selected to close the tabs. 

• Menu consolidation has resulted in the following changes: 
o The File | File Maintenance menu is now the File | Utilities menu. 
o The Database Tables (e.g. CPT, payers, guarantors) menu item is now available 

on the File menu. 
o Data Import & Data Export menu items on the File menu have been 

consolidated to a single menu item. 
o Log On/ Off is now a single menu item on the File menu. 
o Appointment Scheduler has been removed from the View menu. Press the 

calendar toolbar button to activate the scheduler. 
o The Audit Log has been moved from the View menu to Reports. 
o Disk Space has been moved to File | Utilities from the File menu. 

• The former Reports, Design Tools & Database Tables menus have been converted to a 
new format. For example, if you select Reports from the menu, a new tab will appear:  

o The tab will be split into two parts. 
o On the left, a tree now contains all the menu choices which were previously 

available on the Reports menu in v9. 
o Click on any report in the tree and the options will be displayed in a tab on the 

right. You can click on multiple reports to install multiple tabs. Each tab has 
separate data filters. However, for any report you select, data filters remain in use 
so you can make minor changes (if necessary) after each report is generated. 

o Click on an item in bold with a folder icon to display further options in a sub-tree 
(or toggle the sub-tree closed if it’s currently open). 

o The splitter window can be adjusted as necessary with your mouse.  
• If you minimize the program, right click your mouse over it and select either Restore or 

Maximize from the popup menu to restore the program. 
• A new menu option that allows you to print the grid is available on pop-up menus when 

you right click on the ledger or appointment scheduler. 
• Appointment printouts now appear in color on color printers. Print previews remain b/w 

until a related problem with color backgrounds can be corrected. 
• Assigned facility can now be printed on CMS 1500 forms by selecting the appropriate 

override on the payer Printed Claim Options tab. 


